(




—

1 - Pengantar ESP32

ESP32 adalah sebuah komputer mini yang digu-
nakan untuk segala macam mesin otomasi yang
memiliki fituor canggih nhamun dengan harga yang
sangat terjangkau. Jenis komputer ini sedikit berbeda
dengan Personal Computer (PC) ataupun Laptop yang
sering kita lihat. ESP32 masuk ke kategori mikrokontr-
oler, yaitu mini komputer yang mengerjakan sistem
ofomasi tanpa menggunakan spesifikasi yang tinggi
seperti pada laptop atau PC.

Mikrokontroler sudah sering kita temui di ke-
hidupan sehari-hari. Dimanapun Anda lihat sistem oto-
masi, sudah dimungkinkan di dalamnya tferdapat
mikrokontroler. Contoh sistem-sistem otomasi yang
menggunakan mikrokontroler adalah: mesin cuci,
vending machine, BLU-RAY player, mesin kasir, dsb.

ESP32 adalah salah satu macam mikrokontroler
yang sangat umum untuk digunakan sebagai media
pembelajaran. Anda dapat memanipulasi suatu sistem
otomasi dengan mikrokontroler dengan kombinasi
sensor dan output seperti relay atau motor DC. ESP32
memiliki keunggulan dibandingkan macam mikrokontr-
oler lainnyqa, yaitu sudah tertanam modul WiFi dan
Bluetooth di dalam satu board saja.
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1.1 Perlengkapan Yang Diperlukan

Ada baiknya kita mempelajari mikrokontroler
ESP32 dengan perlengkapan yang memadai. Anda
akan belajar mengenai rangkaian listrik dasar yang
berfungsi untuk menghubungkan sensor-sensor ke
ESP32 dan juga perangkat-perangkat output seperti
relay dan motor DC. Selain pengetahuan mengenai
hardware, Anda juga harus bisa membuat kode untuk
menjalankan program mikrokontroler ESP32. ESP32
mengenali bahasa C sebagai bahasa pemrograman
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utamanya. Anda akan menggunakan aplikasi Arduino
IDE yang sangat mudah digunakan untuk membuat
program mikrokontroler ESP32.

Breadboard

Adalah alat yang berfungsi sebagai penghubung
jalur-jalur listrik untuk sensor-sensor dan kom-
ponen-komponen ke ESP32. Breadboard sering juga
disebut dengan project board. Sesuai dengan naman-
ya, bentuknya adalah sebuah papan yang dilengkapi
dengan koneksi khusus untuk membantu eksperimen
rangkaian listrik.




Ada aturan dalam memasukkan kaki komponen
ke dalam breadboard. Jalur-jalur breadboard telah
didesain secara ergonomis supaya mempermudah
penggunaan dalam rangkaian eksperimen. Berikut
bentuk aturan jalurnya.
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Dapat Anda lihat garis-garis yang utuh menunjukkan
koneksi yang common atau satu jalur. Lazimya, garis
yang berwarna hijau adalah untuk kaki-kaki komponen
dan yang berwarna merah-biru digunakan untuk jalur
daya dan ground.

Jumper

Merupakan salah satu komponen penting yang
berfungsi sebagai kabel penyambung rangkaian. Ser-
ingkali Anda akan tidak cukup dengan menancapkan
komponen-komponen Anda pada breadboard. Maka
untuk membuat rangkaian yang komplit Anda perlu
bantuan dari jumper.
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Ada 2 macam jumper yang akan sering digu-
nakan yaitu, dupont jumper dan kabel tunggal. Dupont
jumper memiliki variasi yaitu Female-Male, Male-Male
atau Female-Female. Kabel tunggal tentunya dalam
bentuk Male-Male, namun Anda dapat memotongnya
sesuai ukuran yang diinginkan.

Komponen-komponen lainnya akan mengikuti sesuai
dengan bab yang akan dipelajari nanti. Namun, kemu-
ngkinan besar Anda akan memerlukan LED (Light Emit-
ting Diode), Push Button, dan Resistor sebagai kom-
ponen pokok di setiap proyek mikrokontroler.
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1.2 Arduino IDE

Anda perlu familiarisasi dengan pemrograman
pada Arduino IDE. Anda akan belajar bahasa pemro-
graman secara prosedural yang artinyq, perintah yang
Anda tulis akan dilaksanakan baris per baris. Ini mer-
upakan filosofi dari bahasa pemrograman C yang
menjadi dasar dari Arduino IDE. Instalasi program ini
sangatlah mudah. Anda tinggal mengunduh file ap-
likasinya dari https://www.arduino.cc/en/software
dan sudah, begitu saja.

Yang perlu diperhatikan adalah, ESP32 membu-
tuhkan library tambahan untuk dapat diprogram
dengan Arduino IDE karena sebenarnya program ini
dibuat untuk mikrokontroler keluarga Arduino. Namun,
karena fleksibilitas yang tinggi, ESP32 dapat dipro-
gram di sini.
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Library ESP32

1. Klik File > Preferences.
8 teste | Arduino 1.8.13

Fie Edt Sketch Tools Help

Mews

Open.. Ctrl« 0O

Open Recent

Sketchbook

Examples

Close ChrleW
Clrl=5

Save As.. Cerl+Shift-5

Page Setup  Ctrls Shift+P

Pririt Chrl+P

Preferences  Cul+Comma

Quit

2. Di dalam Anda perlu mengisikan sebuah link pada
Additional Boards Manager URLs: dengan link
https://dl.espressif.com/dl/package_esp32_in
dex.json. Tekan OK.
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4. Akan muncul window baru untuk mencari esp32.
Ketikkan esp32 pada kolom search.

5. Umumnya Anda perlu instal USB Driver CP210x
untuk kompatibilitas USB dari DOIT DEVKIT. Link
unduh:  https://www.silabs.com/products/devel
opment-tools/software/usb-to-uart-bridge-vep-
drivers. Lalu install seperti program biasa.

6. Ganti board Arduino IDE ke ESP32. Klik Tools >
Board, kemudian pilih DOIT DEVKIT Vi1.
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Archrye Sketch

Flash Frequen
dSpeed
bug Level:
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Ecard Info

Programmer: "A'

7. Pilih port yang digunakan untuk ESP32. Klik Tools >
Port: pilih port yang sesuai.

& WiFScan | Arduino 1.8.13 =

Tools Help

WINA Firmware Updater

Board VKIT
Upload Speed

Flash Frequency: "8

Core Debug Level: *!
Port: "COMS"

Board Info

Programmer
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2 - Pemrograman Dasar ESP32

Kita akan belajar kode-kode program dasar yang
sering digunakan pada Arduino IDE. Pertama-tama

kita harus mengenal pin dan port yang ada pada
ESP32.

ESP32 DEVKIT V1 - DOIT

version with 30 GPIOs

Standar dari DOIT DEVKIT terdapat 30 GPIO yang
dapat digunakan. GPIO adalah interface yang digu-
nakan untuk memberi input atau mendapatkan output
kepada/dari ESP32. Yang akan dimanipulasi pada
mikrokontroler adalah pin GPIO ini untuk mendapatkan
sistem otomasi yang diinginkan. Contoh: Anda dapat
membuat alarm kebakaran online dengan input sensor
gas dan output pesan yang dikirim WiFi ke smartphone
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Anda.

2.1 Blinking LED

Sebelum masuk ke penulisan kode program, kita
pelajari kode yang tersedia pada Arduino IDE exam-
ples. Pada examples sudah disiapkan program-pro-
gram sederhana untuk menjadi wadah pembelajaran
seperti blink, WiFi scan, interrupt, dsb. Kali ini kita coba
blinking LED yang cukup simpel.

1. Klik File > Examples > Basic > Blink.

@ teste | Arduino 1.8.13

0 pen

B

Open Recent
Sketchbook
Examples
Close

Save AnalogReadSerial
BareMinimum

Blink

DigitalReadSenial

Save As..

Page Setup

Print i 05.Control Fade

06.Sensors ReadAnalogVoltage

Preferences tri+« Comma

Qunt “irle 0

11 ArduinolSP
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2. Anda akan mendapatkan kode seperti di bawah
ini.

// the setup function runs once when you press

LED BUILTIN as an output.
UT) ;

op function runs over and over again forever

// turn the TED on
// wait £«
// turn the LED

// wait for a second

3. Unggah program blink ke board ESP32 Anda
dengan mengklik Upload.

4. Hasil dari program akan menghasilkan kedipan
LED yang tertanam pada ESP32.
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2.2 Digital Read & Write

ESP32 dapat memanipulasi sinyal digital untuk
input maupun output. Tegangan maksimum yang diop-
erasikan ESP32 adalah 3,3 volt dengan ground O volt.
Dua level tegangan ini digunakan sebagai sinyal digi-
tal yaitu logika HIGH pada 3,3V dan LOW pada OV.

Contoh program Digital Read-Write adalah LED yang
hidup ketika switch on. Berikut kodenya.

\ mmm 2021




= of the pushbutton value:
= digitalRead (4

// check 1 he pushbutton is p ed. If it is he buttonState is
HIGH:
if (buttonst == HIGH)
// turn LED on:
digitalWrite (2, HIGH);

turn LED off:

digitalWrite (4, LOW);
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Wiring diagram menyerupai gambar berikut.

Kode program ini akan menghasilkan output LED
yang hidup selama push button ditekan. Ketika push
button dilepas maka LED akan mati.

Bila Anda perhatikan ada baris kode yang meng-
gunakan variabel dengan tipe data integer (int button-
State). Variabel ini digunakan sebagai penyimpan nilai
digital O atau 1 dari digitalRead() yang kemudian dile-
watkan pada control flow if.
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void setup()
Merupakan program utama Arduino IDE sketch
untuk memerintahkan mikrokontroler pertama kali
dan sekali saja. Umumnya digunakan untuk me-
nentukan kondisi inisial dari seluruh pin yang akan
digunakan.

void loop()
Merupakan program utama Arduino IDE sketch
untuk melakukan perintah setelah insialisasi void
setup() dan terus mengulang baris kode selama
ESP32 tidak dimatikan atau reset.

digitalRead(#GPIO)
Memiliki 1 argumen, yaitu pin GPIO keberapa.
Fungsi dari digitalRead() adalah untuk membaca
sinyal digital yang diterima apakah HIGH atau
LOW, dapat juga berupa nilai integer 1 atau O.

digitalWrite(#GPIO, state)
Memiliki 2 argumen, yaitu pin GPIO keberapa dan
state sinyal digital apakah HIGH atau LOW. Tujuan
dari digitalWrite adalah untuk menghasilkan sinyal
digital HIGH atau LOW pada pin ESP32 yang dipilih.
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pinMode(#GPIO, mode)
Memiliki 2 argumen, yaitu pin GPIO keberapa dan
mode pin tersebut apakah sebagai input atau
output.

2.3 Analog Input

Selain sinyal digital, kita juga dapat membaca
sinyal analog pada pin input analog ESP32. Pemba-
caan nilai analog tersebut tergantung dari level
tegangan yang di inputkan ke pin analog. ESP32
dapat membedakan level tegangan dari OV - 3,3V.
Nilai tegangan ini dikonversikan ke nilai interger
dengan resolusi 12 bit, yang artinya dalam skala O -
4095.

Voltage levels between OV to 3.3V

—

0 4095
oV 3.3V

Pin-pin yang dapat membaca input analog hanya
yang bertanda merah pada gambar di bawah ini. Pin
tersebut adalah GPIO: 2, 4, 12, 13, 14, 15, 25, 26, 27, 32,
33, 34, 35, 36, dan 39.
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:

GPIO23 | | V'SP MOSI
GPlo22 I
GPIO1

RTC GPIOO Sensor ADC1 CHO | GPIO36&
ATC GPIO3 || sersorvN | ADCI CH3 | GPIO39

ESP-WROOM-32

RTC_GFiO4 5 ) GPIO34
RTC_GMOS

SDA

RTC_GPi0a [ TOUGHD
RTC GPIGS TOUCHS

ATC_GPICS CH: PIO -

VEP MISO

WP CLK

RTC_GPIO7 CHE L

AICGhow [ J 7 ® RandomNerdTutorials.com

FTC_GPOM6 HSPICLE || CHG || ADCZ CHB 5 * CHO TOUCHD | HTC GO0

| NIC_GPMOLS H5P1 ANSD k 2 2 TOUCH2 | HTC GROL2
ATC_GPIOl4 | HSPT MOSI 0 GPI013 A 3 | [ TOUCHSY || HsPICs0 || mec Ghoi3 |

Di bawah ini adalah contoh program analog input
yang akan membunyikan piezo buzzer ketika melewati
nilai tegangan tertentu.
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digitalW
delay (30

gitalWrite (buzzer , LOW);

Program ini akan menghasilkan bunyi buzzer apa-
bila pembacaan nilai analog input lebih dari integer
3000. Apabila analog input kurang dari 3000 maka
buzzer tidak berbunyi.

Berikut adalah skema rangkaian untuk eksperimen
analog input dengan output buzzer.

----------
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Serial Monitor

Arduino IDE dilengkapi dengan fitur monitoring
yang dapat menampilkan segala output ataupun input
yang masuk ke mikrokontroler ESP32. Berikut adalah
contoh kode dari serial monitoring.

label global

= 7.

I

Berikut adalah hasil serial monitor yang menunjukkan
nilai tegangan yang masuk pada pin input analog.
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3 - Pemrograman Lanjut ESP32

Setelah mempelajari pemrograman dasar dari
ESP32, kita dapat memasuki pemrograman lanjut yang
sedikit lebih kompleks. Di sini Anda akan belajar lebih
dalam tentang flow control dari bahasa C dan peng-
gunaan library sebuah sensor.

3.1 Servo

Servo adalah sebuah alat output yang dapat di-
gunakan bersama ESP32. Servo berfungsi sebagai ak-
tuator yang bergerak berotasi dari O — 180 derajat.
Umumnyaq, servo digunakan dalam aplikasi penggerak
pintu gerbang atau lengan robot.

Tower Pro |
| SG92R |

_Micro serve
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Servo memiliki 3 pin yaitu jalur data, tegangan
supply dan ground. Cara kerja servo adalah bergerak
berotasi dengan timing yang berbeda-beda. Semakin
cepat waktu maka semakin besar derajat rotasi yang
ditempuh dan juga sebaliknya.

Pengaturan kecepatan putar servo diatur oleh pin
jalur data yang menerima kiriman sinyal PWM dari
ESP32. Sinyal PWM atau Pulse Width Modulation
adalah sinyal DC yang diputus-putus dengan tujuan
mengubah daya rata-rata nya. Dengan adanya sinyal
PWM Anda dapat menggerakkan servo sesuai lokasi
derajat yang Anda inginkan.

Library

Dengan Arduino IDE, Anda dapat menggunakan ber-
macam-macam library yang ada di internet. Kebanya-
kan sensor yang akan Anda gunakan membutuhkan
library tambahan supaya pemrograman menjadi lebih
mudah. Kali ini akan dicoba memasukkan library Servo
ke dalam Arduino IDE.

Berikut langkah-langkah yang perlu dilakukan.
1. Klik Sketch > Include Library > Manage Libraries.
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Help
Tpile Ctri=R
Cerle U

Upload Using Programmer  Ctrls Shift-U

Export compiled Binary Cirl+ A

Chrl=K

Include Library
Add File.. Manage Libraries...  Ctris Shift-|

Add ZP Library...

Bndge

2. Pada search bar, tuliskan servo. Kemudian klik in-
stall.

o Library Manager x

ol & great number of

Accessones

Thie ie a library for Arduino to handle accecsories like lights, motore, Thic library can handle coil motors, stepper motors.,
i

Adafruit PWM Servo Driver Library
by Adafruit
Adafruit PWHM Serve Driver Library Adafrult WM Servo Driver Library
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Setelah ter-install maka Anda dapat memulai menulis
program untuk servo. Berikut contoh programnya.

pinMode (button

void loop(){

int value

int wval
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Pada program ini terdapat 2 buah input yaitu push
button dan 1 buah output yaitu servo. Servo akan
bergerak dari O — 180 derajat apabila push button per-
tama ditekan. Sebaliknya, servo akan bergerak dari
180 - O derajat apabila push button kedua ditekan.
Ada beberapa hal baru yang Anda lihat pada kode
tersebut.

#include <library.h>

#include digunakan untuk menyisipkan sebuah
library ke dalam program. Library berfungsi untuk mer-
ingkas baris kode sehingga penulis program hanya
perlu memasukkan fungsi-fungsi yang sudah di-
siapkan. Contoh di atas menunjukkan penggunaan
library servo, ditulis <Servo.h>. Anda tinggal perlu me-
masukkan GPIO yang ingin dipakai pada nama_ser-
vo.aftach() dan wuntuk menggerakkannya ditulis
nama_servo.write().

Tentunya, Anda dapat memprogram servo terse-
but tanpa menggunakan library, namun sangat tidak
disarankan, karena penulisan kode program yang
akan lebih panjang. Jika Anda ingin mencoba, servo
memerlukan PWM untuk bekerja, sehingga Anda harus
memprogram dengan PWM.
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Object
Merupakan syntax untuk membuat obyek. Dalam
kasus ini Anda memberi variabel untuk penamaan

servo yang akan Anda pakai. Pada contoh kode di
atas digunakan nama test_servo.
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4 - Koneksi Wireless ESP32

Salah satu kelebihan ESP32 dengan mikrokontr-
oler lainnya adalah kemampuan untuk koneksi wireless
tanpa tambahan modul eksternal. Pada ESP32, sudah
tertanam modul WiFi dan Bluetooth yang dikemas
dalam ukuran yang sangat minimalis. Pada bab ini
akan dibahas cara memprogram WiFi dan Bluetooth
pada ESP32.

4.1 WiFi

Program paling sederhana untuk testing koneksi
WiFi pada ESP32 adalah WiFi scan, yaitu program
yang bertujuan untuk menampilkan WiFi Access Point
yang terdeteksi di sekitar ESP32 yang Anda gunakan.

Berikut adalah blok dia-
gram dari WiFi scan
ESP32. Pada Serial Moni-
tor akan dapat dilihat
daftar Access Point yang
terdeteksi oleh ESP32.
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Pada Arduino IDE, Anda dapat menggunakan Example
Program WiFi scan. Berikut lokasi Example-nya.

1. Klik File > Examples > WiFi > WiFiScan.
& sketch_may26a | Ardumo 1.8.13 - o

File Edit Sketch Tools

New

Open

Open Recent
Sketchbook
Examples

Close

Save

Save As..

Page Setup  Cirl-Shift+P

Prnt Ctrl-P
Preferences Ctrl»
Qunt
WiFiMuta
SPIFFS s WiFiScan

Ticker

WebServer
Wik
WiFiChentSecure

WiFPrav

2. Kode tersebut terihat seperti berikut.

1d library,
nt file you n




vorks

Serial.print(" (

Serial.print (WiF

lerial.prant (")
ial.println((

AUTH OPEN) 2" ":u+") .
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. Setelah Anda Upload kode tersebut ke ESP, maka
akan muncul hasil scan pada Serial Monitor Anda.

g Npcap Loopback Adapter
No Internet

%Mbomdicﬁaaur

Connected, secured
Properties

(.

/7 COFEEA

Network & Internet settings
Change settings. such as making a connection metered.

@ = oW

[ Autoscroll [ ] Show tmestamp WiFi
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Pada hasil capture di atas dapat Anda lihat hasil
scan pada Serial Monitor dan notifikasi WiFi pada Win-
dows 10. Selain nama dari Access Point, program WiF-
iScan juga menampilkan kekuatan sinyal dalam satuan
desibel. Semakin kecil nilai desibel maka sinyal sema-
kin buruk (semakin negatif).

Webserver

Selanjutkan kita akan mencoba membuat jarin-
gan sederhana Client - Server. lIstilah ini dapat
diibaratkan seperti pengunjung dan perpustakaan.
Pengunjung merupakan Client yang ingin meminjam
informasi. Pihak perpustakaan adalah penyedia infor-
masi yang bertindak sebagai Server.

Pada jaringan internet, Client dan Server mas-
ing-masing memiliki alamat IP yang umumnya Anda
ketahui dalam bentuk 4 angka yang dipisahkan
titik-titik, contoh : 192.168.100.1.

Anda dapat menggunakan Example Program
dari Arduino IDE, untuk mengimplementasikan koneksi
Client — Server. Pada program tersebut, ESP32 akan
bertindak sebagai server, dimana Smartphone/Laptop
Anda bertindak sebagai Client. Ketika Client mengak-
ses Server, maka Server akan merespon dengan
sebuah kalimat pada browser Anda dan juga menge-
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dipkan lampu LED pada ESP32

$#include <WiFi.h>
#includ ‘WiFiclient.h>
#include

¢include

// 1isi ssid

const char¥

const char¥*

void handl
digital

"hello

e Not Found\n\n";

fr

s

" I’;ET n

" Etﬂ,f_‘;T L L




r.arg (i) + "\n":
SEIXVE

digitalWrite (led,

Ed
id,

wWait for

while (WiFi C INNECTED) {
C (500) ;
Fial prantin T):

intim(=");
int ("
println(s
Serial.print ("IP addre:

Serial
Serial.println(WiFi.l

if (MDNS.begin("esp32")) {
rial.println ("MDNS res arted") ;

r.on("/", handle

/inline", [1() {

d (200, "text/plain”, "ti
.onNotFound (handleNotFound) ;

begin () ;
.println ("HTTE




}

void loop (void) {

server.handleClient () ;
delay(2):;//allow the cpu to switch to other tasks
}

Setelah Anda jalankan program di atas, buka Seril
Monitor untuk mendapatkan alamat IP dari ESP32
Anda (tiap jaringan pasti berbeda).

Kemudian akses browser Anda dari Laptop/Smart-
phone dengan memasukkan IP dari ESP32 Anda ke
pencarian.

192.168.43.56/ X

= G © £ 192.168.43.56

T N [P ———
neillo 1rxon L—f-]°*

- -

Hasil dari pencarian adalah kalimat “hello from
esp32!" yang dapat anda sunting pada sketch Ardui-
no. Selain itu, LED built in pada ESP Anda akan hidup
selama 1 detik kemudian padam.

Catatan penting dalam percobaan ini adalah
Anda hanya dapat membuat jaringan Client — Server
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pada WLAN lokal Anda saja. Untuk akses secara
global perlu digunakan teknik khusus dengan tunnel-

ing.

4.2 Bluetooth

Perbedaan WiFi dengan Bluetooth adalah tipe
jaringan yang digunakan. WiFi tentunya menggunakan
infernet sebagai jaringan uvtama untuk menghubung-
kan ESP dengan Smartphone Anda. Sementara Blue-
tooth, menggunakan jaringan peer-to-peer, yaitu jar-
ingan dari titik ke titik antar ESP32 dan Smartphone
Anda.

Untuk mempermudah pengerjaan, digunakan
bantuan aplikasi Serial Bluetooth Terminal yang perlu
Anda install pada Smartphone Anda. Link:
(https://play.google.com/store/apps/de
tails ?id=de.kai_morich.serial_bluetooth_terminal).
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#include "Bl

BluetoothSerial ESP BT; //0Object for Bluetooth

digitalWri
}

void lo P 'r) \

if (ESP_BT.available())
Bluetooth
I
1
ing =
ial.print ("

if (incoming ==

1

LED turned ON") ;

, LOW) 7

LED turned OFE");
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Setelah Upload kode di atas ke ESP32 Anda, laku-
kan pairing Bluetooth antar Smartphone dengan
"ESP32_LED_Control”. Kemudian buka aplikasi Serial
Bluetooth Terminal pada Android Anda dan koneksikan
Smartphone dengan ESP32. Ketikkan 1 pada console
untuk menyalakan LED, atau O untuk mematikan LED
pada ESP32.

=  Terminal N B

07:22:32.232 No device selected

07:22:34.012 No device selected

07:22:41.889 No device selected

07:22:46.065 Connecting to ESP32_LED_Control ...
07:22:47.952 Connected

07:23:08.124 1

07:23:08.201 LED turned ON

07:23:15.504 0

07:23:15.595 LED turned OFF

M1 M2 M3 M4 MS M6

>
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